**Chronicling Our Lives and Times**

by Curt B. Witcher

I trust some of your Thanksgiving holiday celebrations included time to share stories and memories with family members. And I hope those moments put you in the mood to make this entire holiday season a time of capturing family stories and preserving them for future generations. Those memory moments are truly the best times in our holiday seasons. Your life in your words is the very best gift you can give to your descendants.

So many things remind us to make time for the important activities of recording and sharing. The Genealogy Center issued a challenge at the end of last month for you to set a genealogy goal. Such a goal could be to spend a certain amount of time each week researching, or to write a several thousand word narrative on a particular branch of the family or a favorite ancestor, or to scan a couple of hundred photographs in an organized manner such that the images can be linked in your genealogical database and shared with other family members. Did you set a specific goal? Are you making tangible progress? For the last several years, the day after Thanksgiving has been designated the National Day of Listening. Did you listen? Did you pick-up on this year's theme and remember the teachers who were a part of your life?

As you are putting together your holiday lists of things you'd like to receive as gifts or things you're shopping for, remember to include some of the wonderful pieces of technology that help record and preserve our stories. There are amazingly compact digital audio recorders that will capture more than six hours of conversation at a time. What a great tool to have at this season's family gathering! Yes, your iPad and Android can capture images, but wouldn't a fine digital camera with 8X+ optical zoom and many mega pixels for getting premium images of those records, gatherings, and even HD video recordings be a fine complement to your family history tool kit? Who couldn't use a FlipPal for mobile scanning needs? You would assuredly make use of its image-stitching software. Roots Magic just came out with version 5 of their terrific software, if you're looking for
an easy to use yet full-featured genealogical program. Family Tree Maker just released their 2012 edition software that will sync data on your desktop with your online trees at Ancestry.com.

Finally, as your end of December thoughts may turn to making New Year’s resolutions, I challenge you to make at least one very specific family history resolution that deals directly with chronicling your life and times, and the lives and times of your ancestors. Please don’t settle for something as vague as “I’m going to do more research” or “I’m going to talk to my older relatives more.” Those resolutions are typically broken almost as soon as they are made. Rather, commit to putting a Gedcom file on WeRelate.org by the start of the RootsTech conference in Salt Lake City on February 2nd, resolve to put at least two hundred family photographs on 1000Memories.com by Valentine’s Day, or set aside the third Saturday afternoon (yes, the entire afternoon!) of each month to talk with living family members about your shared family history. Increasingly, with state governments and the federal government restricting our access to records that document our heritage under the guise of protecting our privacy and identity, what we leave behind in the form of records, recordings, and images that we generate may be the best of what our descendants will have of our life stories.

Best wishes for an extraordinary holiday season filled with many wonderful moments with family and friends.

*******************************

Medal of Honor Recipients
by Dawne Slater-Putt, CG(sm)*
*******************************

Since the Civil War, the Medal of Honor has been awarded to soldiers and sailors who exhibit extraordinary valor in combat, usually considered beyond the call of duty. A two-volume set of books compiled by George Lang, Raymond L. Collins and Gerald F. White titled “Medal of Honor Recipients 1863-1994” (973 M467) provides detailed information about the nearly 3400 men and one woman who had received this prestigious award from the Civil War through the Nicaraguan Campaign of the early 1990s.

The data for each soldier includes rank, arm of service, date and place of birth, date and place of death, cemetery, place of entry into service, unit, battle or place of action and date, date of issue of the medal, and reason for the award. For example, Frederick Randolph Jackson was born 18 February 1844 in New Haven, Connecticut. In June 1862, while serving in Company F of the 7th Connecticut Infantry during the Civil War, he had his left arm shot off during a charge on the enemy at James Island, South Carolina. Jackson participated in a second and a third charge before becoming exhausted from blood loss. He died 14 February 1925 at Smithville, New York and was buried there.

Mary Edwards Walker, the one woman awarded the Medal of Honor, served as a Contract Acting Assistant Surgeon at the Battle of Bull Run and other locations during the Civil War and was a prisoner of war in Richmond, Virginia, for four months.

Soldiers’ sketches are arranged chronologically by war or service period. Several appendices in Volume II help researchers who may be interested in studying the information from another angle,
however, and include a master index by surname, lists of recipients by state, and a section on foreign-born recipients of the Medal of Honor. In addition, a table of Medal recipients gives statistics on how many Medals were awarded for each branch of the service for each war or service period. The specific requirements for an individual to be eligible for the Medal of Honor have changed over the years, and Volume I includes a history of the award that explains these changes as well as design changes in the physical Medal throughout its existence.

[“CG” & “Certified Genealogist” are service marks of the Board for Certification of Genealogists, and are used by authorized associates following periodic, peer-reviewed competency evaluations.]

*********************************************************

Delaware Tax Assessment Records
by John D. Beatty
*********************************************************

Tax records offer researchers a useful substitute for census records, providing information about the financial status of residents aged at least 21 years. From the seventeenth to nineteenth centuries, Delaware conducted several colony-wide and statewide assessments, listing owners of both real and personal property. The earliest of these consisted of lists of residents paying quitrents in each of Delaware’s three counties, Kent, New Castle, and Sussex. They exist for various dates between 1681 and 1713. Bruce A. Bendlıer’s transcription, “Colonial Delaware Records, 1681-1713” (GC 975.1 B43co), is arranged by precinct and contains a few detailed descriptions of real property.

In 1782, Delaware undertook its first statewide tax assessment. The resulting lists were published by the Delaware Genealogical Society under the title, "Delaware - 1782 Tax Assessment and Census Lists" (GC 975.1 D37t). Taxpayers are listed both in original order by hundred (similar to a township) and alphabetically.

The Genealogy Center also owns a number of nineteenth century lists that have been reproduced on microfiche under the title, "Delaware Tax Assessment Records" (cabinet I-2). The earliest, from 1803-04, consist of assessments levied on both real and personal property and contain images of the actual assessments with arrangement by hundred. In New Castle County, assessors kept tax “workbooks” with more detailed information about specific items of personal property, which were then summarized in the final assessment volumes. Like an agricultural schedule, they list the specific number of various types of livestock for each owner. The workbooks are extant for all hundreds except Appoquinimink and White Clay Creek. For Kent and Sussex counties, only the summary volumes remain.

Tax assessment books for later years are also available on microfiche. For 1816-17, only the records of New Castle County exist. Arranged by hundred, they include detailed summaries of both real and personal property, as well as “error lists” of delinquent or indigent residents. Karen Ackerman’s “Tax Assessments of New Castle County, Delaware, 1816-1817” (GC 975.101 N43a) contains a transcript of the microfiche. Another assessment on microfiche for 1852-53 is nearly complete for New Castle and Sussex counties, though the lists of only four hundreds remain from Kent County.

Taken as a whole, these lists offer excellent primary source records for documenting Delaware
ancestors. At a minimum, they allow you to locate someone in a particular time and place. Sometimes they can also provide clues to other nearby relatives, and they often include names of people who were not listed as heads of household on the federal censuses.

 ***************************************
Technology Tip of the Month--The Microsoft Word 2010 Ribbon: References Tab, Part 1
by Kay Spears
 ***************************************
For those of you compiling a family history, this tab includes many useful tools organized into the following groups: Table of Contents, Footnotes, Citations & Bibliography, Captions, Index, and Table of Authorities.

A Table of Contents is always a handy tool for researchers and Microsoft Word has made it relatively painless to create one. You can build a Table of Contents in Word either manually or by using a wizard. Before looking at both of these methods, I suggest that you delay making a Table of Contents until your book is nearly complete. It will be less confusing and you will be less likely to introduce a mistake because of any changes you have made while compiling your book.

Let's explore the manual method for creating a Table of Contents. These instructions may seem like a lot of work, but once you get used to them, you'll find that they are pretty easy. You may even decide to incorporate the Tab Alignment for other purposes. First, make sure that the Show/Hide feature is turned on. You will find Show/Hide in the Paragraph Group on the Home Tab (it looks like a backward P). Once you have completed setting up your tabs, you may want to turn off Show/Hide, as it does clutter the page.

Now, type the first entry for your Table of Contents – for instance, “John Smith.” Press the Tab key on your keyboard, then type the page number for the first entry. If Show/Hide is turned on, you should see an arrow between the name and number: that arrow is called a tab stop. Using your cursor, select that arrow, go to the Page Layout or Home tab and click on the Paragraph group. Then click on the Tab button located in the lower left corner. In the Tab Stop Position, type the number of inches of space you want between the name and number. Under Alignment, click Right. Under Leader, select the option you want and click OK. Your page number should align right with whatever leader you've chosen. Press Enter on your keyboard and start typing the second name and number, remembering to press the Tab button after each name entry. You should start seeing what looks like a Table of Contents.

To create a Table of Contents using the wizard, you will need to incorporate the use of Headings in your document for any text that you want to appear in the Table of Contents. The title of each chapter or section is a common choice. Select the text for the first item that you want to appear in the Table of Contents. Next, click on either Heading 1 or Heading 2 in the Styles group on the Home tab. Then, click on the spot where you want to place the Table of Contents - most likely a blank page near the beginning of your document. Finally, on the References tab, in the Table of Contents group, click Table of Contents, then click the table style you want and it will magically appear.

Next Article: The Microsoft Word 2010 Ribbon: References Tab, Part 2.
Quick-Tip of the Month for Preservation--Weeding your photograph collection
by Dawne Slater-Putt

With the advent of digital photography, it is perhaps easier to keep our current photograph collections under control. Since we can preview the pictures we take, it’s a quick step to delete any that are blurry or poor in composition. Also, we may tend to print only the photos that we plan to give to others or put in frames or photo albums.

But what about those boxes of older photographs? How can we get control of our snapshot chaos? Here are some tips:

* Gather all photographs together and sort by time period, or by subject if appropriate (such as in the case of school portraits).

* Be ruthless! Throw out any photos that are bad, i.e., out of focus, too light, too dark, of poor composition, or unflattering. Make an exception to this rule if you have no other pictures of the person or event. (Note: Before throwing away your "bad" photos, take one last look to be sure the background doesn’t capture something of interest like a former residence, the family pet or a car you once owned.)

* If you had duplicate prints made, give away or throw away the second copy.

* Label your photos with a marker or pencil made specifically for this purpose. Other types of pens and markers will bleed through the photo paper.

* Organize pictures in photo-safe boxes with dividers or in archival quality photo sleeves in binders.

LDS/FamilySearch Online Film Ordering
by Cynthia Theusch

Now you can have the benefit of ordering microfilms from Salt Lake City online while planning your research trip to The Genealogy Center. The combination of The Genealogy Center's collection and the availability of microfilms identified in the Family History Library Catalog can enhance your opportunities for research success. When planning your trip to Fort Wayne, consider ordering microfilms from the FamilySearch Microfilm Ordering Service approximately 3 to 4 weeks before your visit.

To access the order form online, you will need to have a FamilySearch account. If you already have created an account in order to see digital images at FamilySearch.org, you can use that account to order microfilm. To create an account, go to www.FamilySearch.org, click on the "Sign In" link in the upper right hand corner and scroll down to the Create New Account button.

The new online ordering system will alert you if the microfilm you chose is already on loan to The
Genealogy Center. Notifications will be sent when your order has been processed, when it has been
delivered to your selected location, and when the item is ready to be sent back to FamilySearch. At
that point in time, you will be able to extend a microfilm's loan period or place it on indefinite loan
for an additional fee. For additional information, a User's Guide is available.

Please contact The Genealogy Center if you have any questions about the new FamilySearch
Microfilm Ordering Service.

***************************************
WinterTech: Locating Books Online
***************************************

Anticipating colder days and grayer skies, increasingly you may want to stay inside and do more of
your research on your computer. Discover sources for locating books (and maybe even view them)
online with the second program in our 2011-12 WinterTech series, "Locating Books Online." This
program will be on Wednesday, December 14, 2011, at 2:30 PM in Meeting Room C. Held in the
afternoons on the second Wednesdays, November through February, to coincide with the Allen
County Genealogical Society of Indiana’s monthly evening meetings, WinterTech expands your
knowledge of family history research using technology. Other WinterTech sessions in January and
February will provide a virtual tour of The Genealogy Center’s Catalog, and a survey of the
Origins.net website for British, Irish, and Scots research. For more information, see the flyer at
or email Genealogy@ACPL.Info to register.

***************************************
Out and About
***************************************

Curt Witcher
Bloomfield Hills, MI--Joint program of the Detroit Society for Genealogical Research and the
Oakland County Genealogical Society, Christ Church Cranbrook, 470 Church Street, 1:30 p.m. to 4
p.m. “And the Rockets’ Red Glare: Online Resources for War of 1812 Research.”

***************************************
Area Calendar of Events
***************************************

Allen County Genealogical Society of Indiana (ACGSI)
December 14, 2011--Allen County Public Library, 900 Library Plaza, Fort Wayne, Indiana. 6:30 p.m.
refreshments and social time, 7 p.m. program. Walter P. “Skip” Sassmannshausen will present: “I’ve
Been Working on the Railroad.”

Allen County-Fort Wayne Historical Society, 302 East Berry, Ft. Wayne, IN
No George R. Mather Sunday Lecture Series presentation in December 2011.
January 1, 2012, 2 p.m. Sara Gabbard will be speaking on, “Mystic Chords of Memory: The Opening
of the West in American Memory.”

***************************************
Driving Directions to the Library
***************************************
Wondering how to get to the library? Our location is 900 Library Plaza, Fort Wayne, Indiana, in the block bordered on the south by Washington Boulevard, the west by Ewing Street, the north by Wayne Street, and the east by the Library Plaza, formerly Webster Street. We would enjoy having you visit the Genealogy Center.

To get directions from your exact location to 900 Library Plaza, Fort Wayne, Indiana, visit this link at MapQuest:
http://www.mapquest.com/maps/map.adp?formtype=address&addtohistory=&address=900%20Webster%20St&city=Fort%20Wayne&state=IN&zipcode=46802%2d3602&country=US&geodiff=1

>From the South
Exit Interstate 69 at exit 102. Drive east on Jefferson Boulevard into downtown. Turn left on Ewing Street. The Library is one block north, at Ewing Street and Washington Boulevard.

Using US 27:
US 27 turns into Lafayette Street. Drive north into downtown. Turn left at Washington Boulevard and go five blocks. The Library will be on the right.

>From the North
Exit Interstate 69 at exit 112. Drive south on Coldwater Road, which merges into Clinton Street. Continue south on Clinton to Washington Boulevard. Turn right on Washington and go three blocks. The Library will be on the right.

>From the West
Using US 30:
Drive into town on US 30. US 30 turns into Goshen Ave. which dead-ends at West State Blvd. Make an angled left turn onto West State Blvd. Turn right on Wells Street. Go south on Wells to Wayne Street. Turn left on Wayne Street. The Library will be in the second block on the right.

Using US 24:
After crossing under Interstate 69, follow the same directions as from the South.

>From the East
Follow US 30/then 930 into and through New Haven, under an overpass into downtown Fort Wayne. You will be on Washington Blvd. when you get into downtown. Library Plaza will be on the right.

***************************************
Parking at the Library
***************************************
At the Library, underground parking can be accessed from Wayne Street. Other library parking lots are at Washington and Webster, and Wayne and Webster. Hourly parking is $1 per hour with a $7 maximum. ACPL library card holders may use their cards to validate the parking ticket at the west end of the Great Hall of the Library. Out of county residents may purchase a subscription card with proof of identification and residence. The current fee for an Individual Subscription Card
Public lots are located at the corner of Ewing and Wayne Streets ($1 each for the first two half-hours, $1 per hour after, with a $4 per day maximum) and the corner of Jefferson Boulevard and Harrison Street ($3 per day).

Street (metered) parking on Ewing and Wayne Streets. On the street you plug the meters 8am - 5pm, weekdays only. It is free to park on the street after 5pm and on the weekends.

Visitor center/Grand Wayne Center garage at Washington and Clinton Streets. This is the Hilton Hotel parking lot that also serves as a day parking garage. For hourly parking, 7am - 11 pm, charges are .50 for the first 45 minutes, then $1.00 per hour. There is a flat $2.00 fee between 5pm and 11pm.

Genealogy Center Queries

The Genealogy Center hopes you find this newsletter interesting. Thank you for subscribing. We cannot, however, answer personal research emails written to the e-zine address. The department houses a Research Center that makes photocopies and conducts research for a fee.

If you have a general question about our collection, or are interested in the Research Center, please telephone the library and speak to a librarian who will be glad to answer your general questions or send you a research center form. Our telephone number is 260-421-1225. If you'd like to email a general information question about the department, please email: Genealogy@ACPL.Info.

Publishing Note:

This electronic newsletter is published by the Allen County Public Library’s Genealogy Center, and is intended to enlighten readers about genealogical research methods as well as inform them about the vast resources of the Allen County Public Library. We welcome the wide distribution of this newsletter and encourage readers to forward it to their friends and societies. All precautions have been made to avoid errors. However, the publisher does not assume any liability to any party for any loss or damage caused by errors or omissions, no matter the cause.

To subscribe to "Genealogy Gems," simply use your browser to go to the website: www.GenealogyCenter.org. Scroll to the bottom, click on E-zine, and fill out the form. You will be notified with a confirmation email.

If you do not want to receive this e-zine, please follow the link at the very bottom of the issue of Genealogy Gems you just received or send an email to kspears@acpl.lib.in.us with "unsubscribe e-zine" in the subject line.

Steve Myers & Curt Witcher, co-editors